Golden Apple (GA) Scholars of Illinois Program

2023-24

User Guide
# Table of Contents

<table>
<thead>
<tr>
<th>TOPIC</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Golden Apple (GA) Administration Process</td>
<td></td>
</tr>
<tr>
<td>• Application, Certification and Award Determination</td>
<td>3</td>
</tr>
<tr>
<td>• ISAC Identification Number</td>
<td>4</td>
</tr>
<tr>
<td>• Payment</td>
<td>4</td>
</tr>
<tr>
<td>• Determining Award Amounts</td>
<td>5</td>
</tr>
<tr>
<td>• Payment Processing</td>
<td>5</td>
</tr>
<tr>
<td>• Disbursement</td>
<td>6</td>
</tr>
<tr>
<td>• Payment Offset and Reconciliation</td>
<td>6</td>
</tr>
<tr>
<td>Access and Navigation</td>
<td></td>
</tr>
<tr>
<td>• GAP Access User Administration</td>
<td>7</td>
</tr>
<tr>
<td>• Navigation into GA System</td>
<td>7</td>
</tr>
<tr>
<td>GA Student List Eligibility</td>
<td></td>
</tr>
<tr>
<td>• Student List Eligibility: View Screen</td>
<td>8-9</td>
</tr>
<tr>
<td>• Student List Eligibility: Filter Screen</td>
<td>10</td>
</tr>
<tr>
<td>• Student List Eligibility: Sort Screen</td>
<td>11</td>
</tr>
<tr>
<td>• Student List Eligibility: Columns Screen</td>
<td>12</td>
</tr>
<tr>
<td>GA Student Detail Eligibility Screen</td>
<td></td>
</tr>
<tr>
<td>• Student Detail: Eligibility Screen</td>
<td>13</td>
</tr>
<tr>
<td>Overview of the GA Payment Process</td>
<td></td>
</tr>
<tr>
<td>• Accessing GA Payment Screen</td>
<td>14</td>
</tr>
<tr>
<td>• Student Payment List: View Screen</td>
<td>15-16</td>
</tr>
<tr>
<td>• Student Detail: Payments Screen/ Individual Payment Requests</td>
<td>17</td>
</tr>
<tr>
<td>• Student Detail: Payments Screen</td>
<td>18-19</td>
</tr>
<tr>
<td>• Payment Request Entry/Batch Payment Requests</td>
<td>20</td>
</tr>
<tr>
<td>• Payment Request Entry</td>
<td>21</td>
</tr>
<tr>
<td>• Submit Payment Requests Process</td>
<td>22</td>
</tr>
<tr>
<td>• Student Payment Eligibility List: Filter Screen</td>
<td>23</td>
</tr>
<tr>
<td>• Student Payment Eligibility List: Sort Screen</td>
<td>24</td>
</tr>
<tr>
<td>• Student Payment Eligibility List: Columns Screen</td>
<td>25</td>
</tr>
<tr>
<td>Dual-Awarding Students</td>
<td></td>
</tr>
<tr>
<td>• Dual-Awarding Students with MTI, GA and/or SETTW</td>
<td>26-29</td>
</tr>
<tr>
<td>GA Reports</td>
<td></td>
</tr>
<tr>
<td>• GA Payment Reports</td>
<td>30-32</td>
</tr>
<tr>
<td>GA Codes</td>
<td></td>
</tr>
<tr>
<td>• GA Result Codes, Request Codes, Status Codes and Enrollment Status Codes</td>
<td>33</td>
</tr>
</tbody>
</table>
Golden Apple Scholars of Illinois (GA) Program

Application, Certification and Award Determination

Applications for the Golden Apple Scholars of Illinois Program are accepted and processed by the Golden Apple Foundation, and the program is administered in GAP Access in partnership with the Foundation and the participating colleges that Scholars are attending.

Once the Foundation has evaluated applicants and determined who may be eligible to receive benefits of the GA program, the Foundation provides applicant data to ISAC which is uploaded to GAP Access.

The Foundation then completes the certification process in GAP Access and identifies which applicants are currently meeting eligibility criteria for the program. Colleges do not need to complete the certification process for GA, as is done for the Minority Teachers of Illinois (MTI) Scholarship Program.

For applicants certified as not eligible by the Foundation in GAP Access, one of these indicators will be provided:

- Probation
- Exits
- Not Reporting.

As the Foundation completes the certification process, program awarding is automatically determined based on number of years in the program, applicant category, etc., and the Foundation has the capability to override and adjust an award amount in GAP Access, as needed. Any changes to certification data after awarding has taken place are made by the Foundation or ISAC.

After the certification and awarding process has been completed, payment functionality will be made available in GAP Access so that colleges can complete the payment request process for awarded students who are enrolled and continuing to meet eligibility requirements at their institution.

The total number of scholarships awarded each year is contingent upon the funds appropriated by the Illinois General Assembly, and the awarding process does not occur until after a final appropriation has been approved by the General Assembly and the Governor.
Golden Apple Scholars of Illinois (GA) Program

ISAC Identification Number

GA applicants who do not have a Social Security Number (SSN) will be assigned a unique student identification (ID) number by ISAC. The format of the ISAC ID number is similar to a SSN and will remain the same for the student each year as the student continues to receive benefits from the GA program.

For GA applicants who also submit an Alternative Application to apply for the Monetary Award Program (MAP) or who submit an application for another ISAC program, ISAC will work to ensure that the student is identified by the same ISAC ID number for all ISAC programs.

If a GA applicant has already applied for another ISAC program and has been assigned an ISAC ID number, the student should use the ISAC ID number in the SSN field when applying for the GA Program.

For more information on RISE Act eligibility criteria, visit: www.isac.org/students/before-college/financial-aid-planning/retention-of-illinois-rise-act/

For more information on GA eligibility information: https://www.isac.org/isac-gift-assistance-programs/golden-apple-scholars-of-illinois-program/golden-apple-scholars-eligibility-requirements.html

Payment

Golden Apple Scholarships are paid directly to the approved institution of record which certified the applicant's eligibility by submitting a payment request (claim). Payment of scholarship benefits is requested by the school through ISAC, prompting ISAC to authorize a voucher in the amount of the claim and submit the voucher to the State Comptroller's Office. Funds are issued by the State Comptroller directly to the institution. Schools may submit Golden Apple Scholarship claims beginning 10 days prior to the start of the term for which payment is being requested.

As part of our ongoing efforts to best leverage appropriated funds to award as many eligible students as possible, priority payment request deadline dates are established for each term.

Link to ISAC website to view Golden Apple Priority Payment Request Deadline Dates: https://www.isac.org/isac-gift-assistance-programs/golden-apple-scholars-of-illinois-program/ga-payment.html
Determining Award Amounts

When the Golden Apple Foundation certifies that an applicant is eligible to receive a scholarship, an award will display on the Student Eligibility List: View screen.

The amount of each award is determined by the number of years the applicant has been a Golden Apple Scholar (i.e., “Year in Program”). Award amounts are as follows:

• The maximum annual award for those in their first or second year of being a Scholar is $2,500.
  • Semester schools will receive $1,250 per term.
  • Quarter schools will receive $834 for the first quarter, $833 for the second quarter, and $833 for the third quarter per term.

• The maximum annual award for those in their third, fourth or fifth year of being a Scholar is $5,000.
  • Semester schools will receive $2,500 per term.
  • Quarter schools will receive $1,667 for the first quarter, $1,667 for the second quarter, and $1,666 for the third quarter per term.

Communication to applicants regarding their award status is done by the Golden Apple Foundation.

Payment Processing

Colleges submit payment requests using the GA system in ISAC’s GAP Access portal throughout the course of the award year. Colleges can request payment for individual students via the GA Student Detail: Payment screen or in batches for a group of students via the GA Payment Request Entry screen.

Submitting payment requests is a two-step process, which involves generating the request and then submitting the request. By submitting a payment request to ISAC via the GA system, a college is certifying that the student meets all eligibility criteria.

A Payment Result Summary and Invoice Detail Report can be viewed or printed by selecting the report tab in the GA system the day after a payment request has been processed. The report includes Payment Results and Payment Exceptions as well as Invoice Detail about the payment claim. The Payment Results/Exceptions report should be reviewed the day after submitting payment requests to see which requests, if any, did not process as expected.

Payment is made to colleges through an offset process. As part of this process, new payment requests are compared to outstanding amounts owed to ISAC, and payment is made accordingly.
**Golden Apple Scholars of Illinois (GA) Program**

**Disbursement**

Awards are made in multiple disbursements. The maximum award amount per regular school year is $5,000 for those in their third, fourth or fifth year of being a Scholar, and $2,500 for those in their first or second year of being a Scholar.

For full-year awards, semester schools receive two disbursements; quarter schools receive three disbursements. Multiple disbursements are not required in cases where the recipient’s eligibility is not determined until the final term of the award year for which the scholarship is being awarded.

If the student has applied for or is enrolled in a term(s) which is less than the award year, they may receive the full award based on their year in the program.

The Golden Apple Foundation certifies a recipient’s eligibility one term at a time. Only the term(s) that have been certified as eligible will display on the Payment Request Entry screen. (For example, in September, only the fall term payment will be available to request.)

ISAC authorizes a voucher in the amount of the payment invoice and submits it to the State Comptroller's Office, which issues payment to the institution. Colleges can match the invoice number on the Payment Results/Exceptions report with the payment voucher.

Upon receipt of the scholarship funds from the Comptroller, the college should verify the student's enrollment status for the term for which the award was intended.

- If the recipient is enrolled, the institution may credit the scholarship funds to the recipient’s account for expenses due and payable. If appropriate, any balance is to be returned to the recipient.

- If the recipient has withdrawn, or if the college has reduced the amount of the award so as not to exceed the cost of attendance, the college must indicate the reason on the GA Student Detail: Payment screen. The GA system will deobligate the award and the amount will offset a future payment to the college.

If a student fails to meet any of the eligibility requirements during the academic year, all undisbursed funds will be deobligated.

**Payment Offset and Reconciliation**

The Payment Offset and Reconciliation procedures apply to Golden Apple Scholarship payment processing. Refund checks should not be sent for cancellations/adjustments made throughout the award year. Funds should only be returned to ISAC after a final reconciliation has been completed at the end of the regular school year. Information about the payment offset process and reconciliation is located in the Refunds and Unpaid Claims section in the Processes area.
Access and Navigation

The system to administer the Golden Apple Scholars of Illinois (GA) Program is available through ISAC’s Gift Assistance Programs (GAP) Access portal at https://isacportal.isac.org.

All users need a valid GAP Access ID and password to access the system.

ISAC relies on a designated Primary Administrator (usually, the Financial Aid Director) at each institution to authorize users and provide them with the appropriate level of access for each ISAC program.

Once a school user has successfully logged in to GAP Access, the GA information can be accessed by selecting the GA program from the Program list.

Please note that the GAP Access system will time out after prolonged inactivity.
GA Student List Eligibility: View

Once you have navigated to the GA Program in GAP Access, you can view the list of applicants provided by the Golden Apple Foundation who may be eligible to receive benefits of the GA program. The list will initially appear in alphabetical order; however, you may use the Filter, Sort and Columns functionality to customize your view as needed.

In addition to the applicant data, the Student List Eligibility: View screen includes the application date, applicant category, certified date, and annual award amount to date.

Keep in mind…a student cannot receive benefits from more than one ISAC teacher program in the same academic year.

Applicants with eligibility or conflict issues will be identified by icons in the List view, and more information can be obtained on the applicant’s Student Detail screen by selecting the magnifying icon in the first column of the student record.

A yellow lightbulb is an indicator of student eligibility issues, and a red triangle is an indicator of a conflict issue.
• Each recipient’s maximum annual award amount is based on the number of years that they have been a Golden Apple Scholar, rather than their academic level in college.

• The award amount will be automatically populated when the Foundation certifies the student as eligible.

• The Foundation has the ability to override and change the award amount, as needed.

• The maximum annual award for those in their first or second year of being a Scholar is $2,500.

• The maximum annual award for those in their third, fourth or fifth year of being a Scholar is $5,000.

Depending on your computer, monitor, and screen settings, you may need to use the horizontal scroll bar at the bottom of the page to navigate farther to the right to see these columns on the Student List Eligibility: View screen.
You may filter student records by selecting specific categories provided on the **Student Eligibility List: Filter** screen, which can be accessed by selecting the Filter tab.

Once you have selected your criteria from the drop-down menus and/or selected the category options on the right side of the screen, select the **List** tab (located to the left of the **Filter** tab) to generate your customized view or select the **List** tab at the bottom of the screen.

A **Reset** tab is also available to clear multiple selections with one click.
GA Student Eligibility List: Sort Screen

The **Student Eligibility List: Sort** screen provides you with several options for sorting the student list. This screen is accessed by selecting the **Sort** tab.

To sort your list, check the box next to the the data element(s) you would like to sort by, then select the Add arrow to add them to the Selected list.

Use the Move Up arrow to put the data elements in the order in which you would like the list to be sorted.

You can also drag and drop your selection(s) into the Selected or Unselected column.

Selected checkboxes will be sorted descending. Unchecked checkboxes will be sorted ascending.

Once you’ve made all the sorting selections, click on the **List** tab (located to the left of the **Filter** tab) to generate your customized list.

A **Reset** tab is available to clear multiple selections with one click.
The **Student Eligibility List: Columns** screen allows you to select the columns you want to view and customize the order in which they appear. This screen is accessed by selecting the **Columns** tab.

To select a Column for your customized list, click on the column heading to highlight it and then the Add arrow to add it to the Selected list.

Similarly, to remove a column from the List view, select the Column heading in the Selected list and then click on the Remove arrow to add it to the Unselected list.

Use the Move Up and Move Down arrows to put the columns in the order in which you would like them to appear on the List screen.

You can also drag and drop your selection(s) into the Selected or Unselected column.

Once you’ve made all of selections, click on the **List** tab (located to the left of the **Filter** tab) to generate your customized list. A **Reset** tab is also available to clear multiple selections with one click.
The **Student Detail: Eligibility** screen displays information from the student's application as well as certification and eligibility information for the GA program. The purpose of this screen is to allow users the ability to view eligibility details for an individual student record. The **Student Detail: Eligibility** screen is accessed by clicking on the magnifying glass icon in the first column of the student record on the **Student List Eligibility: View** screen.

To select another student's Detail screen, enter a new Social Security Number in the Current SSN field and click on the Go button.

These data elements indicate if an applicant was also awarded **MTI** or **SETTW**.

A student cannot receive the benefits from more than one teaching program in the same award year.

For more information regarding dual-awarding… see pages 26-29.

These data elements indicate if the applicant is a **Deferred Scholar** or a **Pathways Scholar**.

- **Deferred Scholar** is one who is deferred funding in their freshman year/1st year and receive the additional $2,500 funding in their sophomore year/2nd year.
- **Pathway Scholar** is one who enters the program and is already in college. These scholars are entitled to one to three years of benefit, accordingly.
GA Payment Processing

GA payment processing is done using the GA system available through ISAC’s Gift Assistance Programs (GAP) Access portal.

GA payment processing can be accessed by selecting GA under the Programs tab near the top of the screen. Program functions are contingent upon each user program privileges. The administrator must access the User Maintenance area and update the program access and level for each user.

- “None” will grant you zero access to GA data.
- “Update” will grant you the ability to both edit and view GA data.
- “View” will grant you the ability to only view GA data (i.e., no editing ability)

After completing the payment request process in GAP Access, payment is made to colleges through an offset process. As part of this process, new payment requests are compared to outstanding amounts owed to ISAC, and payment is made accordingly. This system was developed to accommodate the many changes in student eligibility that can occur during the awarding and disbursement of financial aid (including decreases, increases to awards, initial requests, and full refunds). Therefore, funds should be returned to ISAC only after a final reconciliation has been completed at the end of the regular school year. All schools with an outstanding amount owed to ISAC at the end of the school year receive a notice indicating the total amount to be returned.

Information about the payment offset process and reconciliation is located on the Refunds and Unpaid Claims page in the Processes area of the FAA section at isac.org.
The Student Payment List: View screen gives the user the ability to easily select students to view payment-related items such as payment request amounts, payment result amounts, and payment result codes at a glance. It operates like the Student List Eligibility: View screen, allowing the user to select students who are attending their school and to filter and sort the list according to specific criteria.

The initial loading of this page will result in a default view with the following columns:

- Sel (Select)
- Req Sel (Req Select)
- Term Number
- SSN
- Last Name
- First Name
- Annual Award Amount To Date
- Term Award Amount
- School Code
- Request Code *
- Academic Level
- Enrollment Status *
- Ineligible Reason *
- Requested Amount
- Amount Paid
- Adjusted Amount
- Result Code *
- Expanded Result
- Result Date
- Status Code *
- Invoice Number

* All codes can be found at the end of the user guide.

Schools can create a customized Student Payment List: View screen by selecting specific columns to be viewed, as well as use data sorting and filtering.

The Student Payment List: View is accessed by selecting the Payment tab. The following functions are available on the Student Payment List: View screen: View, Filter, Sort, Columns, Payment Request Entry and Submit Payment Requests.

You may need to use the horizontal scroll bar at the bottom of the page to navigate farther to the right to see these columns on the Student Payment List: View screen.
Student Payment List: View Screen

Check the boxes in the **Req Sel** column to select students for payment. Save your selections by clicking on the **Save Selected** button at the bottom of the page.
The **Student Detail: Payment** screen is a multi-purpose screen that allows schools to view payment information or to create or make adjustments to payment requests for an individual student record. This screen is accessed by clicking on the **dollar sign** icon that is on the same line as the student’s last name on the **Student Payment List: View** screen and by selecting the **Payment** tab from the **Student Detail: Eligibility** screen.

In addition to the **Payment** tab, the **Student Detail: Payment** screen contains the following navigation tabs:

- **List** -- to return to the **Student Payment List: View** screen
- **Eligibility** -- to navigate to the **Student Detail: Eligibility** screen

To navigate to another student, enter the student’s SSN in the **Current SSN** field and click on the **Go** button.

---

**The Annual Award Amount To Date** is the amount that the Golden Apple Foundation has certified/awarded a student up to the current date.

The Foundation certifies/awards a student for **ONLY ONE TERM AT A TIME**.

For example: If we are currently in the Fall term, then the **Annual Award Amount To Date** is reflecting the Fall term amount only, not the entire award year.

If the same student is then certified/awarded for the Spring term, then the **Annual Award Amount To Date** will increase to reflect the two term amounts combined.
When requesting payment from the **Student Detail** screen, there are four required fields:

- **Request**
- **Academic Level**
- **Enrollment Status**
- **Requested Amount** (To adjust the system-calculated annual award amount if necessary)

  - The maximum award amount per regular school year is $2,500 or $5,000.
  
  - The **Golden Apple Foundation certifies recipients' eligibility one term at time. Only the term(s) that have been certified will be available for payment.**
  
  - The amount of each award is determined by the number of years the applicant has been a Golden Apple Scholar (i.e., “Year in Program”) rather than the scholar’s academic level in college. Award amounts are as follows:

    - The maximum annual award for those in their first or second year of being a Scholar is $2,500.
    - Semester schools will receive $1,250 per term.
    - Quarter schools will receive $834 for the first quarter, $833 for the second quarter, and $833 for the third quarter per term.
    - The maximum annual award for those in their third, fourth or fifth year of being a Scholar is $5,000.
    - Semester schools will receive $2,500 per term.
    - Quarter schools will receive $1,667 for the first quarter, $1,667 for the second quarter, and $1,666 for the third quarter per term.

  Each of these fields must be completed with the appropriate information for payment requests to be processed properly. If the student is ineligible an **Ineligible Reason** must be selected and a and a zero ($0) should be entered in the Requested Amount field.

Click on the **Save Changes** button to save the payment request, or the **Discard Changes** button to discard the payment request.

As a reminder, the payment request process is not complete until the next step of submitting the payment requests to ISAC has been completed using the **Submit Payment Requests** screen.

To navigate to another student, enter the student’s SSN in the **Current SSN** field and click on the **Go** button.
GA Ineligible Reason

Select the appropriate reason that makes student ineligible.

- Not enrolled *
- Not a US citizen/eligible non-citizen
- Not an Illinois resident
- Defaulted student loan
- Not enrolled in a teacher program
- Conflicting scholarship
- Not making satisfactory academic progress
- Reached max number of years allowed
- GPA not at least 2.5 on 4.0 scale (soph or above)
- Not a HS grad/no GED
- Not enrolled at least half-time *
- Student is not accepting GA

* If an Ineligible request is submitted, all payment for the term will be canceled, unless it is for the reason “Not enrolled” or “Not enrolled at least half time” in Semester 1 or Quarter 1 or 2.
Payment Request Entry

Batch Payment Request

When creating benefit requests for a large number of students, the best option is to do a batch request, which is done by selecting students from the Student Payment List: View screen.

The first step on the Payment Request Entry screen is to select the appropriate academic term using the drop-down box in the Term field (initially blank) for which you will be creating payment requests.

A list of your selected records will not display until you have selected a term.

Once a term has been selected, the list of students you selected on the Student Payment List View for that term will be provided, and you can then begin to enter payment information.
Payment Request Entry

To complete the payment request for each student, enter the required data into the appropriate fields:

**Request** – Select the appropriate item from the drop-down menu options:

- “Payment” to create a payment request
- “Delete” to delete a request that has been created but not yet submitted
- “Ineligible” to make a student ineligible
- “Cancel” to cancel a previously requested award

- **Academic Level**
  - Freshman
  - Sophomore
  - Junior
  - Senior

- **Enrollment Status** – Enter full time or half time status

- **Ineligible Reason** - If the student is ineligible an *Ineligible Reason* must be selected and a zero ($0) should be entered in the Requested Amount field.
  - Note: If an Ineligible request is submitted, all payment for the term will be canceled, unless it is for the reason “Not enrolled” or “Not enrolled at least half time” in Semester 1 or Quarter 1 or 2.

Click the **Save** button to save your data before navigating to a new page.

As a reminder, the payment request process is not complete until the next step of submitting the payment requests to ISAC has been completed using the **Submit Payment Requests** screen.
Submit Payment Requests Process

The Submit Payment Requests screen allows the user to submit payment requests to ISAC for processing. The user can specify which payment request records will be submitted based on Term selected.

This screen is accessed by selecting the Submit Payment Requests tab. After payment requests have been submitted by clicking on the Submit button a message will be displayed indicating how many payment requests were submitted.

To submit payment requests to ISAC for GA payment follow these steps:

– Choose the Term for which the request is being made from the drop-down menu.
– Click on the Submit button to submit the payment request.
– Ensure that a submission message is received and make note of the number of records submitted.

![Submit Payment Requests Screen](image)

*September 2023*
Payment Eligibility List: Filter Screen

The **Filter** screen provides many different options for filtering the **Student Payment List: View** screen. Users can change the records to be viewed on the **Student Payment List: View** screen by setting specific criteria for one or more of the options on the **Filter** screen.

For the **Ineligible** options, if more than one is checked a record must meet all conditions to be included in the filtered view.

Click on the **Reset** button to reset the data to the default values.
Payment Eligibility List: Sort Screen

This screen allows the user to sort the designated columns on the Student Payment List: View screen by something other than the defaulted view of sorting by last name.

For example, the user may select to sort by Enrollment Status. To do so, highlight the column title in the Unselected list of options and click on the arrow pointing to the right.

This will add it to the Selected columns. Then, use the up arrow to move Enrollment Status to the top of the Selected columns. Click on the View tab and you will see a list sorted by Enrollment Status. If the checkboxes next to the Selected columns are checked, the list will be sorted in descending order. If the boxes are left unchecked, the list will sort in ascending order.

To remove a column from the Selected sort list, highlight the column title and then click on the arrow pointing to the left to move it to the Unselected list.

To move all Unselected columns to the Selected list, click on

To clear the entire Selected list, click on Reset
Payment Eligibility List: Columns Screen

This screen allows you to select which columns will be displayed on the **Student Payment List: View** screen, and the order in which they will appear.

To add columns to the **Selected** list, highlight the column title in the **Unselected** list and click the right arrow to send it to the **Selected** list. To remove a column from the **Selected** list, highlight it and click the left arrow to move it to the **Unselected** list.

If you want to re-arrange the columns once they are selected, highlight the desired column and move it by clicking on the up or down arrows until it is in the desired location in the list.

When you click on the **List** tab, the columns will display in the order in which they appear in the **Selected** list.

To move all **Unselected** columns to the **Selected** list, click on 🔄

To clear the entire **Selected** list, click on **Reset**.
Dual-Awarding Students

• If a student qualifies for the MTI, Golden Apple (GA), and/or Illinois Special Education Teacher Tuition Waiver (SETTW), the student must choose which program they would like to use.
  • A student cannot receive the benefits from more than one teaching program in the same award year.
  • ISAC will send the student a letter asking them to choose which program they want to accept – MTI, GA, and/or SETTW.
  • These letters include a deadline date to return the form.

• If a student decides to change which program benefit he/she wants to receive:
  • First confirm that the student has been awarded the other program before cancelling a payment request that may have already been made.
    o For example, make sure the student was awarded funds for MTI before cancelling a payment request for Golden Apple.

• Program teaching obligations:
  • Golden Apple requires a five-year teaching commitment.
  • MTI requires a one-year teaching commitment for each year that the scholarship is received.
  • SETTW requires a two-year teaching commitment.
  • All 3 of these programs will convert to a loan the student must repay if the teaching commitment is not met, plus interest.

---

23 ILLINOIS ADMINISTRATIVE CODE CH. XIX, SEC. 2763.20
MINORITY TEACHERS OF ILLINOIS (MTI) SCHOLARSHIP PROGRAM

b) In any academic year in which the qualified applicant accepts or receives financial assistance through the Paul Douglas Teacher Scholarship Program (23 Ill. Adm. Code 2762), Golden Apple Scholars of Illinois Program (23 Ill. Adm. Code 2764), the Special Education Teacher Tuition Waiver Program (23 Ill. Adm. Code 2765), or the Teach Illinois Scholarship Program (23 Ill. Adm. Code 2768), the qualified applicant shall not be eligible for scholarship assistance under this Part.

(Source: Amended at 45 Ill. Reg. 15332, effective January 1, 2022)
Dual-Awarding Students with MTI & Golden Apple (GA)

- Example of a student for which payment was requested for both the MTI & GA scholarships.

- The college must **CANCEL** one of the scholarships.

- This **WILL BE** an audit finding if not corrected.
Ways to View Students Awarded MTI, GA and/or SETTW

- Click on 🔍 icon.
- This will take you to the **Student Detail: Eligibility** screen.

- Scroll towards bottom of **Student Detail: Eligibility** screen to view if the student was also awarded **GA** or **SETTW**
Ways to View Students Awarded MTI, GA and/or SETTW

- The MTI Student List Eligibility: View screen shows whether a student is also awarded GA or SETTW.
- Scroll all the way over using the scroll bar at bottom of screen.

- Using the ‘Sort’ tab, you can create a list of students who have been awarded MTI, sorted by Award Date.
- You can also create a list of students who have been awarded GA or SETTW.
- After selecting your Sort options, click on the ‘List’ tab to view the sorted list of students.
Payment Reports

All payment results, for processing done through the GA system, can be obtained at various stages in the payment request process through system-generated reports. To create a report, navigate to the Reports tab, and then click on the Create New Report.

The Select Report drop-down menu is displayed below. To select a report, highlight the title and click on the Request Report button. Data range fields will then be provided to allow you to enter start and end dates for the report. The date fields are optional fields, and if left blank, the report will be cumulative.
After requesting a report, you will be returned to the **Reports** screen where a list of reports that have been or are being generated for your school will be provided.

While the report is processing, the status will indicate *In Queue*. The refresh button completes the report. When it is ready, the status will change to *Completed*. To open the report, click on either the Microsoft Word or the Microsoft Excel icon. Additional information about the report, including the date, file size and username of the person who requested the report will also be listed.

Reports displaying the pdf icon are ISAC-generated reports and identifiable by the username *GAInvoice* in the last column of the report list. Typically, this report is made available on the next business day after your school’s payment request has been processed and will remain available if space allows. It is suggested that you save requested reports and the Payment Results/Exceptions report to your systems for future reference.
Payment Results Summary/Invoice Detail

A Payment Results Summary and Invoice Detail Report is generated by ISAC after your school’s payment request has been processed. It will include a Payment Results Report and a Payment Exceptions Report, as well as an Invoice Detail about the payment claim. Typically, the report will be provided in the reports section on the next business day after the request has been processed by ISAC. This report is needed to match the voucher/invoice number and payment.

The Payment Results Summary and Invoice Detail will appear on the report list and can be identified by the pdf icon in the first column and the username of GAInvoice in the last column.

The last page of this report provides invoice information, including amount due to the school and the invoice number.

ISAC authorizes a voucher in the amount of the payment invoice and submits it to the State Comptroller’s Office which issues payment to the institution. Vouchers are emailed to the Financial Aid Director. The invoice number will be referenced on the voucher authorizing payment from the State Comptroller. Colleges can match the invoice number on the Payment Results/Exceptions report with the voucher.
# GA Codes

<table>
<thead>
<tr>
<th>Result Code</th>
<th>Expanded Result Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td></td>
<td>Ineligible for payment due to due to ISAC Default</td>
</tr>
<tr>
<td>F</td>
<td></td>
<td>Full GA units already used</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Request superceded by another request</td>
</tr>
<tr>
<td>J</td>
<td></td>
<td>Ineligible for payment due to calculated award amount of zero</td>
</tr>
<tr>
<td>G Y</td>
<td></td>
<td>Full annual award amount already used</td>
</tr>
<tr>
<td>G P</td>
<td></td>
<td>Full program award maximum already used</td>
</tr>
<tr>
<td>H</td>
<td></td>
<td>Previously paid to your school for requested term</td>
</tr>
<tr>
<td>U</td>
<td></td>
<td>Cancel requested; no prior payment has been made for this term</td>
</tr>
<tr>
<td>Q Y</td>
<td></td>
<td>Ineligible reason processed - not eligible for this academic year</td>
</tr>
<tr>
<td>Q T</td>
<td></td>
<td>Ineligible reason processed - not eligible for this term</td>
</tr>
<tr>
<td>R Y</td>
<td></td>
<td>Payment reduced to maintain GA annual award amount limit</td>
</tr>
<tr>
<td>R P</td>
<td></td>
<td>Payment reduced to maintain GA program maximum award amount</td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>With this payment student attains the maximum number of terms. Student will no longer be eligible for GA payment</td>
</tr>
<tr>
<td>B</td>
<td></td>
<td>Payment increased</td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>Payment decreased</td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>Payment processed - no reported exception</td>
</tr>
<tr>
<td>Y = Annual maximum</td>
<td></td>
<td></td>
</tr>
<tr>
<td>P = Program maximum</td>
<td></td>
<td></td>
</tr>
<tr>
<td>T = Term maximum</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Request Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Payment</td>
</tr>
<tr>
<td>C</td>
<td>Cancel</td>
</tr>
<tr>
<td>I</td>
<td>Ineligible</td>
</tr>
<tr>
<td>D</td>
<td>Delete</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>Updated</td>
</tr>
<tr>
<td>S</td>
<td>Submitted</td>
</tr>
<tr>
<td>P</td>
<td>Payment</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enrollment Status Code</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Half-time</td>
</tr>
<tr>
<td>F</td>
<td>Full-time</td>
</tr>
</tbody>
</table>